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Poster Project Guidelines and Instructions 

HIST 109: U.S. History: 1865–Present (Fall 2019) 

This assignment is worth 20% of the final grade for the 
course. The final PDF is due November 26 by 8:30am.  

Academic posters are a way for scholars in 
many disciplines to display research findings in 

a visually appealing and engaging format. 

What is the Assignment? 
In this assignment you will construct a reasonable and responsible preliminary interpretation of 
a historical person, event, or process based on evidence from primary sources. You will connect 
this evidence to wider themes and discussions in the history of the United States since 1865.  

Your task is to find and examine a selection of primary sources as a way to see into the worlds 
of people and places in the past. For example, if you are interested in the history of Civil Rights: 

 Your topic might be protests against segregation in the 1950s.  

 Your research question might be: “How effective were the strategies used by activists in 
their protests against segregation in the 1950s?” 

 Your evidence will come from primary sources (accounts created at the time of the 
event) such as newspapers, court documents, personal correspondence, etc. 

 Your findings will be discussed in the context of scholarly debates and course themes. 

In your poster you will outline your topic and your specific research question and you will 
explore evidence that helps you tell a story about a significant aspect of American history. 
Specifically, you want to address the following questions: 

 How do the primary sources you found help to answer your research question? 

 What additional questions are raised by your research?  

 How does your evidence connect to important themes, discussions, or scholarly debates 
in the history of the United States since 1865? 

These are the key questions and answers that will be the material for your poster. In sum, your 
poster will be a visual and textual presentation of your topic, research question, findings, and 
connections to scholarly debates.   

Example of a poster created for HIST 109 

Topic Question Evidence Discussion 

What are you 
interested in? 

What do you 
want to find 

out? 

Properly 
documented 
from primary 

sources 

What have 
others said? 
Why is this 
important? 
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How Do I Choose a Topic? 
There are a wide range of potential topics available in this assignment. This is liberating in the 
sense that you can pretty much research whatever topic you find the most interesting. It is also 
challenging because of the scope of the course. Narrowing in on a manageable topic can be 
more difficult than you might at first think. Your best bet is to start early and find a topic that a) 
you are interested in, and b) has enough sources to base an interpretation on. You should have 
a topic in mind before the midterm exam. Use these steps to help in choosing a topic: 

1. Decide on a broad topic or theme. Your topic or theme must be something directly 
related to U.S. History from the end of the Civil War to the late-twentieth century. For 
example: American foreign policy. Examples of other possible themes you could choose 
include (but are not limited to): 

a. Race and racism (e.g. Reconstruction, lingering impacts of slavery, Blacks in the 
military, influence of the Ku Klux Klan, Civil Rights Movement, etc.) 

b. War and society (e.g. reasons for going to war, American role in a particular war, 
the changing nature of warfare, the effects of war on society, etc.) 

c. Social and cultural change (e.g. women’s movements, urbanization and 
industrialization, Progressivism, labor movement, etc.) 

2. Choose a research focus and question. A theme like racism is clearly too broad to be 
dealt with in an assignment of this scope. You need to narrow your focus thematically, 
geographically, and temporally. You might choose a particular person or event to focus 
on. Frame your topic with a concrete and specific research question. For example: “How 
did former slaves [WHO] in the southern United States [WHERE] adjust to life after 
slavery? [WHEN]” 

Developing Your Research Focus 
The poster assignment is essentially an extension of the primary source analysis activities done 
in class. For example, in class on September 20, our research focus will be to investigate the 
dispossession of Indigenous peoples in the American West. The question will be: “How did 
federal government policies work to undermine the survival of Indigenous societies?” 

To give another example, you may be interested in the Reconstruction period (1865–1877). You 
may want to know more about how race and racism influenced or provided a backdrop to 
government policies and relationships with minority groups in this period (this is your research 
focus). You may ask a question like: “How did the American government’s treatment of blacks 
compare with their policies toward American Indians?” If you are having difficulty coming up 
with a topic, please come see me during office hours as soon as possible! 

In this assignment you are being asked to construct a reasonable, preliminary, interpretation of 
a past person, event, or process based on evidence drawn from primary sources. You are NOT 
being asked to “prove” anything! It is very difficult to make a conclusive argument based on a 
small selection of sources. Historians spend years, sometimes even decades, researching their 
topics before they come to any conclusions. Even then, others will disagree and the debate will 
continue.  Refer back to course learning outcomes 4 and 5 to see what is expected of you: 
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4. Draw on evidence from primary sources to investigate the causes and/or outcomes of a 
significant historical event or process. 

5. Use evidence from primary and secondary sources to construct a reasonable and 
responsible interpretation of a significant person, event, or process. 

Researching Your Topic 
Whatever the topic/theme, research focus, and question you choose, your project will only be 
successful if there are adequate primary sources available. If, after choosing a topic, you spend 
some time researching, but do not find adequate sources, you may need to choose a new topic. 
It happens, and it is not the end of the world. However, in order to avoid this situation, if you 
are at all unsure about your topic, please talk to me as soon as possible!  

If it is October 22 and you are still trying to figure out what you will write for your proposal the 
next day, you are going to be hard-pressed to finish the assignment satisfactorily.  

Additional aspects of the research and writing process are discussed in the assigned readings 
from Jules R. Benjamin, A Student’s Guide to History, 14th Edition (Boston: Bedford/St. Martin’s, 
2019). We will also discuss primary and secondary sources and the research process in class and 
will practice analyzing sources through case studies. Below are ideas and resources to help you 
find relevant sources for your project. 

What are Primary Sources? 
Primary sources are the essential material of historical research. Primary sources provide direct 
evidence on the topic in question. Primary sources were produced at the time, or shortly after 
the period you are studying. Primary sources are from the past. 

Primary sources include oral traditions, journals and diaries, letters, government publications, 
speeches, censuses, published books and articles, video and audio recordings, legal documents, 
court records, contemporary images, memoires and autobiographies…the list goes on. 

There are many ways to find primary sources. Google is not a bad place to start, but you should 
be cautious—it is often difficult to tell what is reliable and traceable. There are many primary 
sources online, and there are also primary sources and collections available in the Library. We 
will discuss these in more detail in class, and further information is found in Guide to History. 

Many university libraries (especially in the United States) have extensive collections of links to 
primary source websites on American history. Below is a small selection of these sites. Note 
some links on these sites may be broken, or you will not be able to access them because of 
geographic restrictions or lack of a subscription: 

 University of California San Diego 

 Bowling Green State University 

 Thomson Rivers University 

 University of Southern California 

 Fordham University Internet Modern History Sourcebook 

https://ucsd.libguides.com/c.php?g=90745&p=583907
http://libguides.bgsu.edu/c.php?g=227222
https://libguides.tru.ca/americanhistory/primarysources
http://libguides.usc.edu/ushistory/primary_sources
https://sourcebooks.fordham.edu/mod/modsbook.asp


HIST 109 | Fall 2019 | Derek Murray | No Restrictions on Use 4 

Where Do I Find Secondary Sources? 
The best place to find secondary sources is by looking for books in the Library catalogue or 
looking for articles in the Library’s databases. You can try a Discovery search to get started. 
When searching, have handy a list of keywords that you will use. See chapter 10 of Guide to 
History for more advice on researching your poster project. 

How Should the Poster Look? 
Short answer: it’s up to you! Long answer: 

 An effective poster will introduce your topic, research question, and key findings.  

 Give the poster a descriptive AND engaging title. Your title should be catchy enough to 
get the viewer’s interest, but it also needs to clearly explain the focus of your project. 

 Use images to illustrate key points. Images may be reproductions of primary sources 
(e.g. a scanned image of a photo) or they may be representations of your research 
findings (e.g. a chart depicting population growth in a particular community). Do not 
clutter your poster with too many images. One to three images will normally suffice. 

 Caption all images with a complete reference. 

 Keep text to 500-600 words and use an accessible font type and size. Edit carefully! The 
test of a good poster is if someone can read it in five minutes or less and have a solid 
understanding of your main points. 

 Academic posters are usually quite large (3x4 feet). For our purposes, the posters will 
be 12x18 inches (this is the largest size that CapU Print Services can handle).  

 Posters can be in either colour or black and white, though some colour is a good idea! 

 Text should be large enough that it can be read from several feet away. For example, 
titles should ideally be in minimum 48 point and body text and tables in 14-18 point. 
Captions and reference lists (footnotes) can be in 12-14 point font. 

 You do not need special software to create an attractive poster. Posters can be created 
using Microsoft PowerPoint or similar programs. Below is a guide designing a poster 
using PowerPoint. You may use a different program if you wish. 

How Do I Create a Poster in Microsoft PowerPoint? 

1. The computers on campus all have Microsoft Office 2013. There are 60 computers in the 
Library alone and there are several other computer labs on campus that you can use 
(e.g. LB 316). If you are having trouble with the program, ask at the IT Help Desk. 
Additionally, all registered students have access to free Office 365 applications. 

2. Start by opening a new PowerPoint window. Choose “Blank Presentation” and then 
select the “Design” tab at the top of the page.  

https://www.capilanou.ca/mycapu/it-services/students/email--office-365/
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3. Select the “Slide Size” option on the right-hand side and choose “Custom Slide Size”. 
a. It is up to you whether you want to create 

the poster in landscape or portrait mode, 
though landscape is typical. The following 
instructions use landscape orientation. 

b. Set slide “Height” to 12 inches (30.48 cm). 
c. Set slide “Width” to 18 inches (45.72 cm). 
d. If asked to choose “Maximize” or “Ensure 

Fit” choose “Maximize”. 

4. Now you are ready to start designing your poster! I will leave this part mostly up to 
you, but if you have questions, please ask ASAP. 

a. Use the “Insert” tab to select options that allow you to insert pictures or text.  
b. Play around with design and formatting, but make sure your primary focus is 

on the CONTENT of the poster more than the appearance. Flashy design will 
never make up for a lack of substance! 

c. Make sure to save and backup your poster often so you do not lose changes. 

5. When you are finished creating your poster, save it as a PDF. Go to the “File” tab, 
select “Save As”, choose a location for the file, and then select the “PDF” option. 

a. When saving your file, use the following format: “hist109_poster_Name.pdf”, 
for example: “hist109_poster_MurrayD.pdf” 

 
 
 

 

 

 
 

 
 
 
 
 

Choose “PDF” for 
final submission 
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Evaluation Criteria and Peer Feedback Process 
Your poster is intended to convey the historical significance of a chosen topic using evidence 
drawn from multiple primary sources and engaging with scholarly debates. Posters will be 
displayed in an attractive and engaging manner, using both visual and textual elements. The 
following specific factors will be considered in evaluating each poster: 
 
Content and Analysis (60%) 

 The topic and question are relevant to the history of the United States since 1865. 

 The question directly addresses core themes or issues from the course content. 

 The focus of the poster is clearly stated and there is a clear and logical connection 
between the topic, research question, and primary sources consulted. 

 The interpretation is based on specific evidence from relevant primary sources. 

 Sources are all properly cited with complete references in Chicago Style notes. 

 Examples from primary sources are used to illustrate findings and support inferences. 

 A sufficient number of primary sources are utilized on the poster (AT LEAST five). 

 Aside from carefully used and cited quotations, all text is in your own words. 

 Research findings are compared with existing scholarship (secondary sources).  

 Specific points of comparison with secondary sources are identified and explored. 
 
Presentation and Formatting (20%) 

 The submitted poster file is saved as a PDF and is formatted on paper size 12x18 inches. 

 The poster title is descriptive and engaging. 

 Images are used carefully to illustrate key points or to display evidence visually. 

 Images are captioned with relevant source information (author, title, date, repository). 

 The poster includes about 500-600 words of appropriate and carefully written text. 

 Font sizes and types are readable and appropriate. 

 Text is grammatically correct, concise, and exact. There are few or no spelling errors. 

 Words are used judiciously and effectively to convey the intended message. 

 All quoted, summarized, or paraphrased passages are cited with Chicago Style notes. 
 
Peer Feedback Process (20%) 

 A 200-250 word proposal is submitted on eLearn by October 23 at 11:55pm. Come to 
class that week ready to discuss your proposal. 

 A complete draft of your poster is submitted in the Poster Workshop on eLearn by 
November 13 at 11:55pm. The draft should include all elements of the finished poster. 

 You provide feedback on assigned peer posters (2-3 posters) during the Workshop 
between November 15 and 20. Feedback is due by November 20 at 11:55pm. 

 Complete two Peer Feedback Forms (on two different posters) during the poster exhibit 
in class on November 29.  

 All feedback provided is thoughtful, detailed, specific, and constructive. 

 Feedback includes specific examples and suggestions where appropriate. 
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PROJECT CHECKLIST AND TIMELINE 
Review the following checklist and put important dates into your calendar or day planner. Then, 
to complete the assignment, proceed through the steps, checking them as you go: 

1. Start by skimming through the textbook and spending some time exploring. 

2. When you have found a few topics you are interested in, start doing some pre-
research by looking at Wikipedia and other online articles. Put together an overview of 
your topic including key dates, events, and people involved. Build a list of keywords for 
your research and think about what kinds of primary sources you will look for. 

3. Decide on a research focus (topic) and begin developing a research question. 

4. Submit your proposal on eLearn before October 23 at 11:55pm. 

5. Use your keywords to search in the Library and in online databases to find as many 
primary sources as you can (at least a dozen would be a good start). In reading, 
viewing, or listening to each source, consider these questions: 

a. What is the nature of the source? (article, diary, court record, letter, etc.) 
b. What do you know about who created it? 
c. What is the context surrounding the source? (where, when, who, why) 
d. What is the intended message or meaning? 

6. Novice historians are often tripped up by moving too quickly to generalizations rather 
than focusing on specific evidence to support their inferences. As we do in class, you 
should select SPECIFIC statements from the documents and ask yourself: 

a. What inferences could be drawn from this statement? 
b. What are the reasons for this inference?  
c. What additional questions does it raise? 
d. What do I need to do to answer those questions? (e.g. context, research) 

7. In this way, analyze AT LEAST FIVE different primary sources. Use your findings to help 
answer your research question and formulate your interpretation. 

8. Go back to the Library catalogue and journal databases and find one or two relevant 
secondary sources related to your topic. These sources should: 

 Be scholarly books or articles written by historians. 

 Be in some way related to your topic even if not the exact same focus. 

9. Create an attractive and engaging poster that introduces your topic, research focus, 
question, what you learned (evidence) and how it connects to scholarly debates. 

 Submit your draft in the eLearn workshop before November 13 at 11:55pm. 

10. Complete peer review of assigned posters between November 15 and November 20. 

11. Revise and submit the PDF version of your poster before 8:30am on November 26.   

12. Come to the Poster Exhibit on November 29 prepared to talk about your poster, 
answer questions about your research, browse the other posters, ask questions about 
others’ research, engage in intellectually-stimulating conversations, and have fun! 

 Submit Peer Feedback forms for TWO different posters. 
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